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Tag List Generator

TAG LIST GENERATOR

TAG LIST GENERATOR and DF65 OPC Server Installation

Introduction

Required System

- Operating System 2 Windows NT 4.0 — Service Pack 6, Windows 2000 (Service Pack 2), or
Windows XP.

- Computer - PC —Pentium Processor 400 MHz or higher.

- RAM - 64 Mbytes (128Mbytes for Windows XP)

- Disk Space = 10 Mbytes of HD.

Preparing the Installation

Using the Smar installation CD “SYSTEM302 Information”, click on the OPC Server V8 and Tag List
Generator V8 to install the DF65 OPC Server and Tag List generator respectively.

The software Tag List Generator for the DF65 OPC Server is developed to generate an information
Table to the DF65 OPC Server telling which the Tags are for each Modbus Address.

In the HMI side, just configure using links to Tags, in this way, if the user changes the DF65
configuration (the Modbus address will change), but the Tags will not. The OPC Server will be able
to read the new Tag List generated after the changes made with the LogicView.

Tag List enables the USER to enter scaled values for Tag values in engineering units. The Tag
Scaling allows the user to convert a raw value (unscaled value from the Device) to a given numeric
range (in engineering units).

Using the TreeView the USER can select, add, create, delete, and edit the List of Communications
Connections (Ports), List of Devices, Types of Conversions.

Under the Controller (Device) Level, a list of Tags will be shown, and the Properties for this Tag will
be visualized on the right Frame of the Main Application Frame.

For each Tag, the user can select if this Tag Value will have Conversion or Not and the Type of
Conversion that will apply for this Tag Value.

The versions 8.54 and later of the Tag List and support the configuration of the MCT for the DF65.
MODBUS Cross Table (MCT) is a technique to optimize variable MODBUS addresses that can
significantly increase the speed of MODBUS drivers when accessing variables in a Smar DF65
system.

Note: This function is only available for DF65 systems with DF65E or DF65ER.
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Using the Tag List Generator

Creating a New Project
To create a New Project, click on the File menu, then click New, or click on New button, on the
toolbar.’

agList ¥& for the DF65 OPC 2.0 Server ¥8.54 - [Untitled.mdb]
File Edit OPC Help

b @

Open

Save

Save As

Export Taglist
Export MCT Working
Export MCT Device

Close

Exit:

Figure 1- Creating a new project

To open an existing project, to save a project or to close the current project just click on the File
menu then click on Open , Save or Close respectively, or click on the icons Open, Save or Close
(Windows standard) on the toolbar.

Adding and Removing ports
The DF65 OPC Server supports all types of port combinations (COM1, COM2, Ethernet) having
serial and Ethernet communication on the same configuration.

Once the user starts a new project, the Tag List will open a window similar to Figure 2. Next, by right
clicking the Communication item, Tag List will display a window where the user can configure the
parameters described below.

TagList v for the DF65 OPC 2.0 Server ¥3.54 - [Untitled.mdh]

File Edit ©OPCZ Help

De Ba=@Ee

| Connec

g Device Lis

LflZ] Conwersion:  Edit

------ [Eil Complete T Remave

Remave All
online
Caormpare MCT Tahbles

Figure 2- Adding a new port

The user must certify that the chosen configuration option (Baud Rate or IP address) is the same
as the DF65 configuration, which will be monitored.
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i%. Add Connection x|

Connection
|ENET

— Sethngs
ScanPeriod | 1.00  zec Fetry Period I 1.00  zec

Timeout I 500 - mEeC Retries IE vl

— Interface

= Serial

Ok |1 vl Baud Rate I 900 "I
FATS Control IDisabIe 'i

[T ET5 Output Cortral

f+ TCRAF

IP Address [132 [168 [168 [ 75

Q. | Cancel

Figure 3- Communication Parameters

Port Settings

Port Name (Connection)
The user must create a Tag for the port to be configured on the Tag List. This tag will be used to
define the first Browser level on the Tag List OPC Server.

Scan Period
It is the time it takes for the DF65 OPC Server to read the Tags (OPC Points) from every slave
devices, that is, the time between cyclic questions.

Retry Period
When the OPC Server Client runs out of configured tries in Retries, it verifies each time interval
established by Retry Period whether or not the connection is active.

Timeout

Waiting time for a response after a message from the DF65 Server is being sent to the slave. After
this period of time, the DF65 OPC Server retries to establish communication, based on the number
configured on Retries.

Retries
Number of times the DF65 OPC Server software will try a new communication after waiting for the
specified value on the Timeout parameter.

Specific Configuration for the serial physical mean

If the user chooses to use serial communication, it can be through EIA-232 or EIA-485. The
connection and cable specification are the same used in the communication between the DF65 and
the LogicView, and are described in the “DF65 Manual”.

Com
Allows the user to choose which serial port will be used for communication.

CTS Output Control
When this parameter is enabled, the OPC Server will transmit only when the CTS is active.
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RTS Control

The options of this parameter are:
Disable: RTS inactive (off)
Enable: RTS active (on)
Handshake: Activates the RTS, if the receiver buffer is % occupied and disables when the receiver
buffer is less than half occupied.
Toggle: RTS will be activated if there are bytes to be transmitted, and RTS will be disables after
every byte is transmitted.

Specific configurations for communication via Ethernet

IP Address

In case of Ethernet TCP/IP communication, the user should set the logic controller Ethernet card’s
IP address (MB700 or ENET700) which should be communicated.

Connection
|ENET
— Sethngs
ScanPeriod | 1.00  zec Rety Period | 1.00  sec
Timeout I 500 - mEeC Retries IE vl
— Interface
= Serial

x|

COM I‘I vl

f+ TCRAF

[T ETS Output Cortral

IP Address [132 [168 [168 [ 75

Baud Rate I 9E00 "I
FATS Control IDisable 'I

Q. | Cancel

Adding a New P

Figure 4- Adding an Ethernet Port

ort

The user can add more serial ports or Ethernet if required. To add a new port, right-click at
Communication Connections and select Add.

[%l TagList ¥& for the DF65 OPC 2.0 Server ¥8.54 - [Untitled.mdb]

File | Edit <PC  Help
L

'yl

Editing/ Removi

ol | ErreomprErE AT

R

Edit

Remove

Remowve All

Crline

Campare MCT Tables

I Caonnection

Figure 5- Adding a New Port

ng Ports

The user can edit or erase a communication Port, for that, just right click on the added port and the
user can change its current settings, or click on Remove to remove the desired port.
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Redundancy

The DF65 OPC Server supports system redundancy. The OPC redundancy follows a main path
philosophy and a redundant path (backup). When the system detects the main path is not
communicating, the redundant path takes over communication. When communication on the main
path returns, again, it becomes the active path and the redundant gets back to being the backup.

The redundant path, even in a state of backup, it tests itself if everything is OK. Each port (main or
backup) notifies its current status through Status.

Redundancy could take place even in different physical means/data link layer: MODBUS TCP and
MODBUS RTU. For example, two Ethernet networks or even one Ethernet network and one EIA
485 network. The user can configure an existing redundant network on the system.

Application Example

Consider an application example shown in Figure A where the DF65 OPC Server monitors points
from 3 DF65 in an Ethernet network. In this case it is used path redundancy for the DF65'’s, which in
case of main path failure; the DF65 OPC Server uses an alternative path for supervision.

HMI/ DF65 OPC Server

HIC 1 (Hetwork Interface Card 1) = == HIC 2 (Hetwork Interface Card 2)
PORT.MAIN PORT. RED

Ethernet 1
(Main Path)

Ethernet 2
(Redundant Path)

EIA-485

P3 P3 P3 ElA-485

Figure 6- An application involving an DF65 OPC Server, DF65 and MB700.

The main path

Right after a new project is created, the Tag List Generator will ask how the DF65 OPC Server and
the DF65 will communicate. The DF65 supports the communication via serial port (232 or 485) or
via Ethernet (TCP/IP). In the case of the next figure, the main path is through the Ethernet port
("Main_Port")




Tag List Generator — User’s Manual

i, Connection Settings i x|
Connection

[Man_par]

— Settingz

ScanPeriod | 1.00 zec Fetmy Period | 1.00  sec

Retries I 7 - I

Timeout | GO0 MSEC

— Interface

" Serial

COM |1 vl Baud Rate I 9600 "'l
RTS Contral IDigable v|
[T ETS Output Cortral

& TCRAP

IP address [132 [169 [168 65

4 | Cancel

Figure 7- Choosing a communication channel

The redundant path

After configuring the main path, the user should add a new port (channel) which will be the
redundant (backup).

. Add Connection i

x|
Connection
|F|eu:|undant_|:|ort

— Settings

ScanPeriod | 1.00  =ec Rety Period | 1.00  zec

Timeautl RO0 | mMec Retries |2 vl

— Interface

" Serial

COM |1 vl Baud Rate I 9600 v|
RTS Contral IDisable 'l
[T ET5 Output Cortral

& TCPAF

IP &ddress [192 [16s [168 [ 21

4 | Cancel

Figure 8- Adding a redundant port
Adding or Removing a Configuration

Before adding a new configuration, the user is supposed to create a configuration in the LogicView
software.

If the user has several DF65’s with different addresses, a configuration file should be generated
(*.PL7, *.PL8) with a different name for each DF65 used in the project.
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Adding a Configuration

AN

i i L1 The configuration must be a valid configuration generated by LogicView from Smar.
L L 5

To add a new configuration the user should open the menu Edit > Add or in the left pane of the
Tag List Application.

agList ¥8 for the DF6S OPC 2.0 Server ¥8.54
File Edit OPZ  Help

D@ Ea ke
L Untitled

E| Connections
ek ENET

o et MAIN_PORT
.2 REDUNDAMT_PORT

%g Device Ligt

: D:urwersic
. (Bl Complete Edit

Remaove

Femowve Al
Cnline
Compare MCT Tables

Figure 9- Adding a new configuration

After the user adds a configuration, the Tag List will open a window (Figure 10) where the user
should choose the file which contains the desired configuration.

2 x|
Look in: IEWDrking j - I'j{ v

DFE5_v7
DF65_v8

File name: IDFEE_\-'B j Open I
Files of bype: ICaniguratiDn [*PL7: *PL3) j Cancel |

&

[™ Open az read-only

Figure 10- Locating the configuration to be added

The user will not be able to include duplicate configuration names, even if in different sub-
directories.

Next the Tag List will open a window for the user to configure a few parameters regarding the
chosen configuration. This configuration is present in the DF65 memory, so a reference is made to
the device.
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Note:

The Block View and
Digital Block
features are only
available for Smar
devices.

Redundancy:

Just enable the
Redundant
Enabled and
inform which one
is the redundant
channel/nort.

i, Add Device x|

¥ Device Enabled Device |D I 1|
[+ Usze BlockMiew [+ Usze Digital Block.

Device Tag:
|DFEs_va

Diirectony:
|E:"-.F'ru:ugram FilezhSmarT agLizt and DFES OFC Server v _I

Config. Mame:
|DFES_va PLS

b ain Carnrm Port [MCP]
|MaIN_PORT =l

Redundant Comm Part [RCF]
|REDUNDANT_PORT =l

[+ Fedundant Paort Enabled

k. | Canizel |

Figure 11- Device Configuration

In the window above (Figure 11) the user must configure a few parameters regarding configuration

and the recently added device.

- Device Enabled: Enables/disables the device. In case this parameter is not selected, the OPC

Server will not monitor it.

- Device ID: Device address in the MODBUS network.

- BlockView: Enabling this parameter the user can compact the commands of the OPC Server,

increasing communication speed.

- Digital Block: Enabling this parameter the user can read all digital points using only

one command of the OPC Server, increasing communication speed.

- Redundant Port Enabled: Enabling this parameter, the user will have enabled the redundant
channel.

The Redundant Enable ICON is displayed as (In GREEN) : ﬁﬁé when it is enabled.

Redundant Disabled ICON is displayed as (In RED) : ﬁﬁ% when it is disabled.

- Main Comm Port: the user should inform which port previously configured will be the main
channel.

- Redundant Comm Port: In case redundancy is used, the user should inform which configured
port will be used as redundant channel.

- Directory: Directory where the added configuration is located. Clicking on . button is
possible change this directory. This procedure is useful when the configurations (.tag and .pl8) are
transferred from any computer to another.

- Configuration Name: Name of the configuration associated as a device (for example, DF65).

- Device Tag: Is the Tag in which the device is referred by the OPC Server

After the ports are added and configured, the user should view a screen similar to the following
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picture. Two ports were included, a main serial port, a redundant port, through an Ethernet port.

P! TagList v8 for the DF65 OPC 2.0 Server v8.54 - [Untitled.mdb]
File Edit OPC Help

O di|dEe

(S Untited | Device Enabled | Part Hame | DevicelD | DevicsName | UseBlock View [ Use Digialf
E‘" Connections 3| Icdl [ MAIN_PORT | T | DFEs_vA | = ‘ =
bl ENET

=l MAIN_PORT

¢ e REDUMDANT_PORT

=18 Devics List

Y DF65_va [MCP: MAIN_PORT] [ACP: RED)
|Z| Conversions
“.[BI] Comnplete Tag List

Figure 12 - OPC Connection through a Serial Port/Ethernet port configured via Tag List

Editing/Removing

Saving the Project

The OPC Menu

a Configuration / Device

To edit or remove a configuration, it is necessary to select the configuration on the main screen.
Right click it, the edit/remove configuration dialog will appear, then just change the desired settings
and click on OK for the changes to take place, or click on the Remove to remove the configuration.

To compile the project (to generate the Tag List) it is necessary to first save the current project.

To save the project using the menu, click on File, then Save (if the project has already a name) or

Save As (if a new you wish to save the project with a new name), or on the icon Save (windows
standard) on the toolbar.

The OPC Menu has the following options:

- OPC Monitor
- Show Active Tag List
- Register Active Tag List

[% TagList ¥8 for the DF65 OPC 2.0 Server v8.54 - [Untitled

File Edit | OPC Help
] =&
@m ShDI.N F'.ctive.Tag Lisk .
E|" Cal Reqister Active Tag Lisk
e T

-t MAIM_PORT

-t REDUNDAMT _PORT
=% Device List

e3® (] DFES_v8 [MCP: MAIN_PORT] [RCP: RED
k=] Conversions

-[Bi] Complete Tag List

OPC Maonikor

Dewir

Figure 13- Accessing the OPC Menu

Registering the Project

After the project name is chosen, it should be registered in Windows, in order for the reading
software of the DF65 OPC Server to recognize which configuration to search for. So every time a

new project or project name is changed, it should be registered, to be indicated as the current
project.

To register a project, just click on the OPC menu, then click on Register Tag List, or click on
Register Configuration, on the Tool bar, as shown in figure below.
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Note

Each change done
in the configuration
in the LogicView, a
new TaglList Table
must be generated.
The user needs to
open the current Tag
List project and
execute the
command to
generate the Tag
List Table again.

File Edit OPC Help

O3 e CoR @

Figure 14- Registering the current Tag List

Generating the Tag List Table

The program will generate the points monitored by the DF65 OPC Server. The Tag List Table
associates the address/Tag in the DF65 with the name/Tag given to it by the OPC server.

While the tag List is being generated, the “Tag OPC” (hame of the DF65 point that will appear for
the user on the OPC client) is assembled as follows:

- If the user defined a User Label on the LogicView for the point, then this will be defined as a
name for the Tag OPC of the point.

- If the user did not define a User Label, then the Tag OPC will be the point’'s Default Label.

To generate the Tag List Table, click on OPC and then Register Tag List, or click on the option
Register Tag List on the Toolbar.

“I TagList v8 for the DF65 OPC 2.0 Server
dle Edt OPC Help

@ e v @

% teste Device Enabled Part Mame Device ID Der
3B Connections

== ENET

== MAIN_PORT

== REDUNDANT_PORT

S Device List

ﬁﬁg DFES_w8 [MCF: MAIN_PORT] [RCF: RED
[ Conversions

IE Complete Tag List

Register Tag List

C:AProgram FileghSmark T aglist and DFES OFC Server
w8 B4\ orkingteste TAG

raguse Y

Registry updated

Figure 15- Generating the Tag List Table

After the project registration and the Tag List generation, the system is ready to monitor the DF65
points using the DF65 OPC Server. The Tag List program does not need to be running, (the Tag List
can be closed). The operational system automatically locates the current configuration for the DF65
OPC Server when activated by a HMI Software (OPC Client).

10
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Verifying the Active Tag List table

In case the user wishes to check which Tag List Project is registered on the computer, click on the
OPC menu, then click on Show Active Tag List, then the program will show the active Tag List.

Viewing the Tag List Table

The user can verify the table generated by the Tag List. In order to make it, click on (+) of the added
configuration, two options are available: Tag List and MCT.

Tag List

The figure below shows the Tag List table generated for the current configuration.

agList ¥8 for the DF6S DPC 2.0 Server ¥8.54 - [Untitled.mdb]

File Edit OPC Help

D HE <w@Ee

E Untitled Tag Address Cotwversion Type Description
EI-- Comnections DIG_0OUT1.0 Qo0 <Monex BOOL ledl
o=l ENET DIG_OUT1.1 ooz <Mone> BOOL  [ledl
o=t MAIN_PORT DIG_OUT1.2 oono3 <Monex BOOL led?
=iz REDUMDANT_PORT DIG_OUT1.3 00004 <Morex BOOL led3
EI% Device List DIG_OUTZ24 Qo005 <Monex BOOL led4
EI@E DFE5_v8 [MCP: MAIN_PORT] [RCF: RED DIG_OUT25 00008 <Mones EOOL led5S
(B Tag List DIG_OUTZ2E noooy <Monex BOOL ledf
[ED MCT DIG_oUT27? 00003 <Morex BOOL led?
""" Conversions TEMPO 0200 <Monex BOOL first light
""" [ET] Complete Tag List b TEMP f200z <Moresr BOOL second light
TEMPZ 02003 <Monex BOOL third light
TEMP3 02004 <Monex BOOL fourth light
TEMP4 02005 <Monex BOOL fifth light
TEMPS 02008 <Monex BOOL zinth light
TEMPE 02007 <Mone> BOOL zeventh light
TEMP? 02008 <Monex BOOL eighth light
TEST.0 02003 <Moarex BOOL
TEST.1 [0 <Monex BOOL
TEST.2 02011 <Moarex BOOL
TEST.3 n2mz <Monex BOOL
TEST.4 02013 <Moarex BOOL
TEST.S 02014 <Monex BOOL
TEST.E 02015 <Monex BOOL

Figure 16- Viewing the Tag List table

In the above table, it can be seen:

- Tag: configuration point names.

- Address: Modbus addresses of the configuration points.

- Conversion: filed to convert the data types.

- Type: data type.

- Description: description done in the LogicView through the Global Table (it can be done also in
the Tag List).

MCT

In this option the user can choose which points will be monitored by the device that uses the
Modbus protocol. Clicking on (+) at left of MCT, two folders will be showed:

- Working

- Device

Type Discrete Outputs Discrete Inputs Analog Inputs Analog Outpts

(0x) (1x) (3x) (4x)

(]
o 250 points 250 points 250 points 500 points

points

11
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Working

Clicking on this folder, four Address Ranges will be open. This folder becomes available the points

which are done download.

- Ox — Digital Outputs and Virtual Points.

- 1x - Digital Inputs.
- 3x—Analog Inputs.

- 4x— Analog Outputs, Function Blocks and Special Registers.

Device

Clicking on this folder, four Address Ranges will become available to visualize the configuration

points.

- Ox — Digital Outputs and Virtual Points.

- 1x - Digital Inputs.
- 3x—Analog Inputs.

- 4x— Analog Outputs, Function Blocks and Special Registers.

Fﬂ TagList ¥8 for the DF65 OPL 2.0 Server ¥8.54 - [Untitled.mdb]

File Edit ©PC Help

O Heg|cn R @

LS Untitled

=B Connections

=tk EMET

b M&IN_PORT

-k REDUMDAMT_PORT
% Device List

..... (ET] TagList
= @I
@ wiarking
(Bl Device
----- [E] Conversions
..... [B] Complete Tag List

Using the MCT

EW@ DFE5_w8 [MCP: MAIN_FPORT] [RCF: RED

| | Device Enabled | Part Mame

Figure 17- MCT Option

When one of the address ranges is selected in the Working folder, a table at left of the Address
table appears. In this table the addresses are added which must be configured. Four buttons also
appear below the screen to do the Tag List table.

Button

=l id

Description

Move the Tags between the lines up and down

Remowve Tag

Remove Tag from the table

Add Cell Add lines in the table
Add All Cellz Add the whole table at once

Delete Cell

Delete lines

12
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% TagList v8 for the DF65 DPC 2.0 Server v8.54 - [Untitled.mdb] =100 x|
Fle Edt OPC Help
Do O ukEe |
@‘ Untitled MCT Working - Ox M odbus Table
El & Cornections | Tag | MCT |Address - Tag Address MCT | Conversion [Id
etk EMNET | o7om P |0IG_0UT1.0 00001 i <Nones e
=tk MAIN_PORT DIG_OUTTA o002 0 <Mone> g
== REDUNDANT_PORT DIG_OUTT 2 0003 i <Nare: Ie
£} B Device List DIG_OUT1.3 00004 i <Nones e
= f) DFE5_v8 [MCP: MAIN_PORT] [RCP: RED DIG 00724 00005 0| <hone =
~(B1) Tag List DIG_OUT25 00006 1] <Nores Iz
=-(E] MCT DIG_OUT26 00007 i <None> e
Wworking DIG_OUT27 00008 i <Mones e
(B[ TEMPO 02001 i <Nones fi
(B 1% TEMF1 02002 0 <Nones &
3 TEMPZ 02003 i <Mone t
(IR TEMP2 02004 i <Mares fe
=-[E] Deviee TEMP4 02005 i <None> fil
Corwversions TEMFE =T i <Nones si
- [B) Complete Tag List TEMFE 02007 i <None: F
TEMPT 02008 i <Mone> @
TEST O 02009 i <Mones
TEST. 0z010 0 <Manex
TEST.2 02011 i <None>
TEST3 02012 i <Nones
TEST.4 02013 i <Nores
TESTS 02014 i <Mones
TEST 6 02015 i <Nones
TEST.? 02016 i <Nores
;IJ < | G
;I LI Remave Tag | Add Cell |
sckd Al Cels Deete Cel |

Smar Laboratories Corp.

Figure 18- MCT Option

Description of the Address Table Columns
Tag: Name of the point
Address: Point Address
MCT: Counter of how many times the Tag was added in the MCT table
Conversion: Allows scale conversion
Description: Point description

Configuring the MCT table

In order to configure the MCT table, follow the steps:

1) Click on the Add Cell button.
One line will be added in the table.

13



Tag List Generator — User’s Manual

MCT “wiorking - Ox

Modbusz T able

Tag

MCT

Address

Tag Address MCT | Canversion

0700

S

b

DIG DUT'I D DDDD1 EI <None>

DIG DUT1 2 0003 li-

DIG DUT2-4 0005 li- :
DIG DUT2 5 00007 li- :
TEMF'D 2001 li- i

TEHP? 203 li-

tP

TEMP4 02105 [0 <Nones i
TEMWPS 02007 [0 [<hone>

restoJoae 1oL ohorey |
K (7T I TS
resta oaos 10 Loore |
reste —Jooots oL oone |

o |

2| =

Remove Tag |

Addtel |

el A1 Cells |

Delete Cell |

Figure 19- Configuring the MCT table

2) Click with the left button on the point which will be added in the table.

MCT Warking - Ox

Maodbus Table

MCT

Address

Tag Address MCT | Conwerzion

07om

o

DIG CIUT‘I IZI DDDD1 D <None>

DlG UUT1 2 0003 E-

DIG DLIT2.4 uuuns li-
DIG ouT 28 DDDD? li-

TEHPD 02001 li-

<Manex

b TEMP1

fii

TEh2 TR T
T s o [auone i

N 7 S P
esto om0 Toie ]
et ons o Toie ]
esTe s 10 Loine

4 |

FRemove Tag |

Add Cell |

Add All Cells |

Delete Cel |

Figure 20- Selecting the points for the Tag table
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3) Click with the right button on the line and drop to the added cell.

Figure 21- Adding points in the Tag table

4) Repeat the steps above to add all the points which must be monitored.

MCT Working - Ox Modbusz T able
Tag MCT Address i Tag Address MCT | Conversion B
» | TEMP1 0700 02002 DIG_0UT1.0 0o 1] sMones =
DIG_OUT1.1 ooooz 1} <Mones Ie
DIG_0UT1.2 0ooo3 1] sMones le
DIG_OUT1.3 0ooo4 1} <Mones Ie
DIG_0UT24 0oons 1] sMones le
DIG_0OUT25 0000g 1] <Mones Ie
DIG_DOUT2E oooor 1] sMones le
DIG_OUT27 0ooog 1] <Mones le
TEMPD 02001 1] sMones fii
/ 1 <Mo k2
TEMPZ 1] sMones th
TEMP3 02004 1] <Mones fe
TEMP4 02005 1] sMones fil
TEMPS 02008 1] <Mones El
TEMPE 02007 1] sMones &
TEMP? 02008 1] <Mones s
TEST.O 02003 1] sMones
TEST1 02010 1] <Mones
TEST.2 02011 1] sMones
TEST.3 0202 1] <Mones
TEST.4 02013 1] sMones
TESTS 02014 1] <Mones
TEST.E 02015 1] sMones
TEST.7 02016 1] <Mones
4 | LIJ 4 | 3
:l Ll Remove Tagl Add Cell |
Ackd a1 Cels | Delete Cell |

The Tag List configuration must be the same which is running in the DF65.

The user can do the upload of the configuration points without do the download previously, in order
to check the DF65 configured points. If the configurations have the same name, it is impossible.

Consistency Check
If any point is configured in the MCT Table, in the Working folder, and it is not in the Total Point
Table, its address will be red.

If any address in the MCT Table, in the Device folder, is red, it means this address is not in the
configuration that is running in the DF65.

Download to the Device

To configure the MCT Table, it is necessary to do the download of the added points. In order to
make it, click with the right button on each one of the address ranges in the Working folder. A popup
menu will be opened, select the Download to Device option. Or click on the toolbar Edit >
Download to Device. See the following picture:

15
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E| Connections

e EMET

=l MAIN_PORT

== REDUNDANT_FORT

% Device List

EIW,Q DFE5_wE [MCF: MAIN_PORT] [RCP: RED

----- (Bl TagList
=B MCT
E[El Wwhorking
Add
Edit
Remave
Remove all

Compare MCT Tables

Figure 22- Doing the Download to Device

After doing the download of the all points that were added in the MCT Tag Table, a message about
the Successful Download will appear.

F TagList v8 for the DF65 OPC 2.0 Server v8.54 - [Projeto_1.TAG] -8 x|
File Edit OPC Help

D gl E e

g Projeta_1 MCT "Working - 0= Modbus T able
El“ Connec.:tions I Tag I MCT I Address = | Tag Address MCT | Conversion Description j
lc: Main_Poit b |M-111G2880003.7 | 07007 | 00016 | [M-111G1880003.0 |000m 0 <Nane> I
i EMET e o noz.1 | 00002 il <Mone:
=l Redundant_Por & DownloartOLEXEEI 2> oo 0 |<None>
IZ—II%: Device List W Use Device Connection R 0 TG
E[ﬁﬁ DFES_v8 [MCP: Main_Port] [RCP: Redund Dievice D |_1 024 |00005 0 <Nanes»
(B Tag List i D025 | 00008 0 <None>
E-EIMCT = Cse | s Looous 0 |<None>
(8] Working & Seral D037 | D000 0 <Nones
[E Part: [ = e | 03.0 [00003 0 <Nane>
0021 | 00010 il <Mone:
Baud Aate: -
saanEs [ se00 F] Sigp Lasking | P22 |00 0 |<Hones
: @;@‘l 4 Paily: [een = 023 | oooiz a <Naone>
EVICE : 03.4 100013 0 <Moner
: Dowrioad | PO one
(] Corwersions RTS/CTS Timeout: IU ownioa TR 5 T
~[B] Complete Tag List [0=Dizablz RTS/ACTS] 036 (00015 0 <Mone:
C TCRAR nOs7 | 00016 1 <Mone>
02001 1] <Mane> first light
IR dsies [19; [ 165 [ 160 [ &5 02002 0 [<Mone secord licht
02003 0 <Mones third light
: 3 02004 o <Maonex fourth light
Additional T I
e e [500 02005 0 |<Mone> fifth light
Mumber of Retries: IU vl 02008 ] <Mane> zixth light
02007 0 <Mones seventh light
r~ Device Information | 02008 o <Maonex eighith light
one:
Configuration: 02011 1] <Maone:
i @ MCT Dowrload Successful, 02012 ] <Mone>
bR 02013 0 <None>
nzma o <Mong>
. i 0 one> -
4 B L3
:I j Remove Tag | Add Cell |
AddANlCells | Delete Cell |
[l | |

Figure 23- MCT Download Successful

The Upload function can not be done successful if the Tag List and DF65 configuration is not the
same.
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Upload from Device

Atfter all points of the MCT Tags Table have been sent to device, the upload of these points must be
done in order to compare them. In order to make it, click with the right button on the Address ranges
in the Device folder, a popup menu will be open, choose Upload from Device. Or click on the toolbar
Edit > Upload from Device.

Fl TaqList v8 for the DF65 OPC 2.0 Server v8.54 - [Proieto 1.TAG] =12l
File Edit OPC Help

D dEg B e

Sl Projeto_1 MCT Device - 0= Modbus Table
- Connestions [Tag [T [ Address [ [770 Address MET_| Conversion [ Desciption =]
E :jrj':?"mt P [+-111G1E80003.0 | 00001 0 <Hore>
Doa1 | 00002 i <MNerer
e Redundant_Por S Upload feoriD g 2IF0e2 Tooos 0 |<Norer
518 Davies List [w  UseDevice Connection 03,3 00004 o Nores
Eﬁﬂa DFES_v8 [MCP: Main_Port] [RCP: Redund Device D |1 034 | oooos il ¢Mores
(B Tay List I 003.5 | 00006 i <Nane>
E-EIMCT g Clnse | boz6 | oooo7 0 <Mare>
Working L 0037 | 00008 0 <Nane>
O Port: [ =1 Lok | boz.0 | oooog 0 <None>
T Bkl 031 | oomo i <None>
3 | Stop Losking | i 2 [ 1 i N
: @ f‘“ Parity: IEVEN vl 0033 | o0oi2 0 <Nones
= evice . o034 00013 0 <M ane:
ATS/CTS Timeout: [a sl |
fmEsk |0 0035 | 00014 0 <Noner
[B-Disable MTSACTES] boz.s [ooms 0 <Nuri
 TCRAP 0037 | 00016 1 <Naone>
02001 u} <Mones first light
-[E] Conversions IS |192 I 162 I 168]) 65 02002 0 ¢Naones second light
~~(B1 Complete Tag List 02003 i <Nare third light
- . 02004 1] <MNonex fourth light
Additional T :
fenelTime st 00 02005 0 |<Norer fiftn light
Mumber of Fetries: r m— 1 02006 1] <Nonex sixth light
B CommitnicAEEREEE X 2007 0 <Nares seventh light
—Nevire Infrrmatine = 02002 [u} <Mone: eighth light
Device @ Upload Successful, MCT Enabled, | 02003 a <Maner
02010 o Mo
Configuration: 02011 1] <Moner
Version: O n2oz o <Mane:
Sreien: 02013 0 <Hore>
I 02014 1] <Maore>
@ Fun @Force @Hold & Fault | 02015 1] <MNones -
1 UL N N - ! L4
- w | Remove Tag | Add Cell |
pddACe: | Delee0el |
« | o

smar Laboratories Corp.

Figure 24- Upload Successful
Upload all Address ranges.

Comparing the Tag Tables

After doing the Upload of all points, it is possible to do the comparison of the Working and Device
Tables. Click with the right button on one of the address ranges in the Working or Device folder, a
popup menu will be opened, choose the Compare MCT Tables option, or do this clicking on the
toolbar Edit > Compare MCT Tables.

17



Tag List Generator — User’s Manual

. Compare MCT Tables - 0x T i ] 4|
‘working MCT Table - 0x Device MCT Table - 0x
I MCT Address I Original Address I Comment I Tag I MCT address I Original &ddress | Comment
i | 00016 [ Ok ] M-11162RE000] 07007 | [0S | Ok
L] | L1 I KT I 2
Feplace Cloge |

Figure 25- Comparing the Tag Tables

It can observe:

- OK: The Device and Working original addresses are the same.

- Tag Mismatch: The Device and Working original addresses are different.

- Not found in Device: the original address was in Working was not found in Device.

There are also two buttons on the right lower corner:
- Replace: replace all points from the Device table to Working table.
- Close: close the active window.

18
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Conversions

For each Tag, the user can select if this Tag Value will have Conversion from Device Range to
Engineering Units, or Not. First the USER needs to create a "Conversion Type" that will apply for a
Tag Value. After having created a Conversion Type, the USER needs to assign this Conversion to a
Tag, or assign to a group of Tags, that use the same conversion type.

When the OPC reads the value from the Device, it will convert this value using the conversion rules
created, and provide the converted value to the OPC Client.

Only Tags with DATA TYPES: WORD, DWORD, INT, and REAL, are allowed to have
CONVERSION, the Other DATA TYPES are NOT allowed. Only Tags that can be represented in
Eng. Units (EU) can be converted.

Tags with DATA TYPES: BOOL and BYTE are Tags that has NO conversion to EU.

{1l TagList v8 for the DFE5 OPC 2.0 Server v8.54 - [Projeto_1.TAG]
File Edit ©OPC Help

D e wEe

@.__]. Projeto_1 Conw Mame Conv Type Low ELI High EU Low Device High Device

=8k Comections Conversdo Linear [~ 0 0 0 10000

*|w

g Main_Paort | Corw Tupe

otk ENET Float
- Redundant_Port
E—]% Device List Square Foat

=i DFES_v8 [MCP: Main_Port] [RCP: Redund
B Tag List
=-(E] MCT
(B Working

= (Bl Deviee
IR
TR
[El Ax

[#-4= Conversions

-[B] Complete T ag List

Figure 26- Conversions

Type of conversion

There are three types of Conversion:

Floating Point Conversion

If the USER checks the Option: “Floating Point Conversion”, the OPC Server will convert the data
into float data type, but will not change the value itself.

Linear Conversion

The OPC Server will use linear conversion between EU and Device scale, if the option: “Linear
Conversion” is checked.

There are two types of units:

EU Engineering Unit (client scale)
Device Device range (device scale)

Square Root Conversion
This conversion performs the following operations:

Ri =Y = (Y —yD) */(y2— y3)

(HighEU — LowEU ) * (Ri — y1)
(y2-yl)

Rf = LowEU +
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Where:

Ri: Intermediate Result

Rf: Final Result after the linear conversion
Y: Tag value

y1: Value defined for Low Device

y2: Value defined for High Device

For this conversion, there is the Cut Off parameter. When the Tag value (Y) is lower than the value
defined for Cut Off, the result of the conversion is zero. When the Tag value is higher or equals to,
the result of the conversion is obtained according to the equations showed above. The linear
conversion is applied to the obtained result, considering the values defined in High Device, Low
Device, High EU and Low EU.

If Y < Cut Off
Then Ri=0
. ~ .ipi
Rf:LOV\IEU{(HughEU LowEU ) * (Ri yl)}
(y2-y1)
IfY 2 Cut Off

Then Ri =Y = /(Y —y1) *\/(y2—y2)

Rt — LowEU J{(nghEU — LowEU ) * (Ri — yl)}

(y2-y1)

Example:

For the Square Root conversion, it considers the values below:
Low Device: 0

High Device: 10000

Low EU: 10

High EU: 50

Cut Off: 10

It has the following results according to the tag values showed below, and the equations presented
above:

Y Ri Rf
(Tag value) (Intemediate result) (in Engineering Unit)
11 331.6625 11.3267
10 316.2278 11.2649
9 0 10
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i, Edit Conversion [ x|

Mame IEnnversEd

— Conversion
" Flaating Paint Comversion

i~ Linear Conversion ¥ Square Boot

Cut Off | 10

Low Device I o LowEU I 10
High Dievice .

| 10000 High EU | ]

— Clamping

[ Clamp Low Clamp I 5
HighClamp [ 15

] | Canzel

Figure 27- Conversion Types

If the “Clamp” option is selected, the data value will be limited to its High Limit Value (High Clamp),
when it exceeds the upper limit, and similarly with Low Limit parameter. The Clamp occurs after the
conversion.

After setting a conversion type, the user can set the conversion for the specific TAG directly in the
Device Tag List. Just choose the TAG, and in the conversion FIELD, click at it and choose the type
of conversion in a drop down list as the following picture shows:

Tag Address Conversion Type Dezcription
TOMZ.CTA 42520 <Monex IMT
TONZ.PST 4251 <Monex IMT
TOM1.5TS 4257 <Mones WORD
TOM1.CTA 42523 <Monex IMT
TOM1.PST 42524 <Monex IMT
TF1.5T5 42575 <Monex WORD
TP1.CTA 42526 <MNone: IMT
TP1.PST 42527 <MNonex IMT

4 TP3.5TS 42529 ~| WORD
TPALCTA 42530 Conw Name |«]  INT
TP3.PST 42531 INT
TP4.5TS 42532 Convers&o | =1 WORD
TP4.CTA 42533 <Monex IMT
TP4.PST 42534 <Mones IMT
TF5.5TS 42535 <Monex WORD
TPRLCTA 42536 <Monex IMT
TFR.PST 42537 <Mones IMT
TPE.STS 42538 <MNonex WORD
TPE.CTA 42535 <MNonex IMT
TPE.PST 42540 <MNonex IMT
TF7.5TS 42541 <MNonex WORD

Figure 28-Using the Conversion
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Status provided by the DF65 OPC Server

After the user has generated the Tag List table, the OPC Client (an HMI interface for example) can
read the variables referred by the Tags. Also, the OPC Server provides some status which contains
additional information.

B Status_Port.<Configured Port Tag >
- CommlD: A number is attributed to the configured port by the Tag List.
- CommPortStatus: Shows the status on the port.
1 - Normal Communication on the port.
0 - Communication failure on the port.
- ActualScan: It is the period the DF65 OPC Server takes to read all devices connected to the
configured port.
- ScanPeriod: It is the value of the Scan Period parameter configured for the port.
- RetryPeriod: It is the value of the Retry Period parameter configured for the port.
- Timeout: It is the value of the Timeout parameter configured for the port.
- Retries: It is the value of the Retries parameter configured for the port.

B Status_Device.<Device Tag containing the configuration>
- MainPortStatus: Indicates the main path’s communication status for the device.
1 - Communication without problems
0 - Failure on the main channel
- RednPortStatus: Indicates the redundant path’s communication status for the device.
1 - Communication without problems
0 - Failure on the Redundant channel
- UseBlockView: Indicates if the user has configured the "Block View" option.
0 - the user disabled this option
1 - the user enabled this option.
- UseDigitalBlock: Indicates if the user has configured the "Digital Block" option.
0 - the user disabled this option
1 - the user enabled this option.
- MainPortID: Indicates the main port number where the device is connected. This value is equal
to CommlID for the specified port.
- RednPortID: Indicates the redundant port nhumber where the equipment is connected. This
value equals to CommlID for the specified port.
- ActivePort: Indicates which path is active.
0 - the Main Path is active
1 - the Redundant Path is active
2 - no path is being used or reading failure
- Enabled: Indicates if the user has enabled or not the device.
- MainScanlnterval: Indicates the real time interval between cyclic readings of all Tags/variables
from the current device, through the main path.
- RednScaninterval: Indicates the real time interval between cyclic readings of all Tags/variables
from the current device, through the redundant path.
- MainActualScan: It indicates the real time taken to read all tags/variables from the current
device, through the main path.
- RednActualScan: It indicates the real time taken to read all tags/variables from the current
device, through the redundant path.
- NbrCommCmmd: It indicates the number of Modbus commands that the OPC Server is
sending in order to supervise the requested points.
- ViewsStatus: Indicates the current status of the Block View current used by the OPC for
scanning the device. The status composition is as follows:
e ViewStatusOx:
0 = Block View not being used
1 = Block View is being used
> 1 = Error on view assembly or view is still being assembled by the OPC.

Where ViewStatusOx:

e ViewStatus01 - Block View Status 01
ViewStatus02 - Block View Status 02
ViewStatus03 - Block View Status 03
ViewStatus04 - Block View Status 04
ViewStatusO01 - Block View Status 05
ViewStatus02 - Block View Status 06
ViewStatus03 - Block View Status 07
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e ViewStatus04 - Block View Status 08

If the ViewStatus value is greater than 1, an error occurred on the assembly or ViewStatus is still
being assembled. The value is a BIT combination, and to know what the status means, the
configured BIT should be known according to the table below:

Block View Status
VALUE
BIT ‘ DESCRIPTION COMMENTS
(DEC)

0 Block View OK 1 If the block view is OK the other Bits should be zero

1 NEED ASSEMBLY 2 \?ii\?v has received a new configuration, and will assemble a new Block

2 IS ASSEMBLING 4 OPC Server is assembling the Block View

3 USE COMMAND LIST 8 An error has occurred during the assembly. OPC is using MODBUS
commands.
Block View assembly has failed — CONFIGURATION ERROR
(Response Code 07(hex)). A possible cause would be an inexistent

4 ASBL RSP CNF FAIL 16 Modbus point. In this case the OPC Server is using individual
commands.
Block View Assembly has failed - BLOCK VIEW IS FULL (Response
Code 0B(hex)) A possible cause would be that there are other Modbus
Masters (other servers for example) accessing the same slave device

5 ASBL RSP BVW FAIL 32 using view. In this case the OPC Server is using MODBUS command
standards and as soon as one of the views is available, it will be read by
VIEW.

(< S —
Block View assembly has failed- (communication failure) — This BIT will

7 ASSEMBLY FAIL 128 be 1, when the bits 4 and 5 fail.
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The OPC Monitor Software

The Tag List has a software that helps the configuration test and can be used to monitor points
using the DF65 OPC Server, and check for errors in the configuration. It is the OPC Monitor. It is
accessed through the OPC menu (see figure 12). Just access the menu OPC-> OPC Monitor.

The OPC Monitor is an OPC client that can work with any OPC Server. In case of DF65 OPC
Server monitoring, it allows the user to view the values of the Configured variables/Tags and the
status described on the previous item.

In case the DF65 OPC Server is used, initially the OPC Monitor will show the screen below, which
the user should choose the Server Smar.DF65Server.1

Smar DF65 OPC Clienk

OPC Server List:

Smar|Server.
[COMICS. Sirnulatar. 1
ICOMNICS.D atawfon<32.1
Smar.DFERS erver.
Smar LT 005 erver. 1
[COMICS . AlarmServer_.1
Smar.DfidleServer.0

Smar. hzeolezerver.(

ServerMame

ISmar.ISewer.D

Connect | Cloze |

Figure 29- Choosing the OPC server for the OPC Monitor

Right after, the OPC Monitor automatically opens the screen shown on figure below.

sir TagList ¥8 for the DF65 OPC 2.0 Server ¥8.55 - [Monitoring DPC ¥alues] - Smar.DF655erver.1 - ol x|
File

Em StatusPort_bain_port |Address |Value |Type |Quality |Nbr 0Of Failz |Time |D
Ba@ StatusPort_FRedundant_part
&[] StatusDevice_DFES_v8
-] DFES_v8

3

i Start Manitaring Add tao Grid Clear Grid | Clear Fail Count | Tags Monitored: 0 I 1000 Secan Time [milliseconds) Cloze |

Figure 30- The OPC Monitor
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On the column on the left, there are (in this order): the channel status, device status and
variables/Tags values. Note that the devices have a specific MODBUS ID and this order must be
respected. Clicking on each item, they are expanded in sub-items. For further details see the
previous item “Status provided by DF65 OPC Server”.

With a left click on the mouse button, the user can select which status, and which variable to
monitor. The screen below shows a few selected status. To remove some status from the monitor
page, just double-click the status or variable in the screen on the left.

Ji7. TagList v& for the DF6S OPC 2.0 Server ¥8.55 - [Monitoring OPC ¥alues] - Smar.DF65Server.1 =101 x|
File

-2 TPE.STS o[ |Tag |ddress [Walue  [Type [Qualty  [NbrOf Fails [Time [Desc [User Tag | Default Tag
-~ TPSICT DFE5_&DIG_0UT10 00001 0BOOL | Good 01.0923PM led0 DIG_OUT1.0 DF27G1B40003.0
2 TPEPST DFE5_va. TEMP? 02008 0BOOL | Good 0 1:03.23PM sighth light | TEMPF YMIBGITIN.?
~[21 TPESTS DFE5_vE.TOTAL 42563 3INT  Good TOTAL OUT.ADD.
~[2 TP&ICT
= TPEPST
-2 TP7.5TS
-2 TPRICT
= TP7PST
= TPESTS
-2 TPRICT
-5 TPRPST
5 TONSSTS
~[21 TONZICT
~[2) TONBPST
(=1 INT_CNST.PRM1
-2 INT_CNST.PRMZ
~[Z1 INT_CNST.PRM2
EINTC_1
E Nt 2

hd| »
StatMonitoing | AvdtoGid | CleaGid | ClearFai Count | Tags Moritrec: 3 000 | Scan Time (millseconds) Close

Figure 31- Viewing Status and Tags

The configurations are right below, and can be expanded. The user can choose which variables to
monitor directly through this variable’s Tag, without worrying about the MODBUS addresses. The
OPC Monitor has some buttons on the lower screen. The “Start Monitoring” button starts the
monitoring. “Clear Grid” erases the status selection and variables previously made. “Clear Fail
Count” is used during monitoring to erase the failure messages on the communication.

With the "Add to Grid" button the user may select one tag or a group of tags (via Ctrl + left click or
left click for mark the first tag and Shift + left click for mark the last tag of a range) and add it to the
tags grid that will be monitored, clicking on this button. The “Close” button ends the program.

TagList v8 for the DF65 OPC 2.0 Server ¥8.55 - [Monitoring OPC Yalues] - Smar.DF65Server.1 =10l x|
Eile
|21 UseBlockView d Tag [Addiess [Value  [Type [Qualty [MbrOfFals |Time [Desc [User Tag | Default Tag
--[=] UseDigitalBilock. StatusPort_Serial-R5232 ScanPeriod a
~[Z) MainPartiD DFES_v8.DIG_IM.0 10001 0/ BOOL control start DIG_IN.O DF20G1B2I002.0
~[2) RednPorD DFE5_v8.0IG_IN.1 10002 0/ BOOL key 1 DIG_IN.1 DF20G1B8I002.1
~[2) ActivePart DFE5_vA.0IG_IN.2 10003 0/ BOOL key 2 DIG_IN.2 DF20G1B8I002.2
[2) Enabled DFE5_vE.DIG_IN.3 10004 0/BO0L key 3 DIG_IN.3 DF20G1B2I002.3
21 MainScanCycls DFE5_vE.DIG_IN.4 10005 0/BO0L key 4 DIG_IN.4 DF20G1B2I002.4
~[Z) RednSeanCycle DFES_vE.DIG_IN.5 10006 0/BO0L key & DIG_IN.G DF20G1B2I002.5
(=) MbrCommCmmd DFE5_v8.DIG_IM.6 10007 0/ BOOL key € DIG_IN.6 DF20G1BAI002.6
-[2) ViewStatus01 DFE5_v8.DIG_IM.7 10008 0/ BOOL key 7 DIG_IN.7 DF20G1B8I002.7
2] ViewStatus02 DFE5_vAINTC_1 42560 0/ INT INTE_1 OUTLIETA
2] ViewStatus03 DFE5_vEINTE 2 42561 0/ INT INTE_2 OUT2ICTA
[ ViewStatus04 DFEE_vEINTC_3 42562 0/ INT INTE_3 OUTZICTA
[ ViewStatus05 DFES_vE.TOTAL 42563 0/ INT TOTAL OUT.ADDT
-2 ViewStatus06 DFE5_vB.RTC_Sec 43951 0/ WORD Seconds [RTC) RTC_Sec RTC_Sec
2] ViewStatus07 DFE5_v.RTC_Min 49952 0/ WORD Minutes (RTC] RTC_Min RTC_Min
-[2) ViewStatus08 DFE5_vE.RTC_Hour 43953 0/ WORD Hour [RTC) RTC_Hour RTC_Hour
{1 DFE5_vE DFE5_vA.RTC_Dwesk 43954 0/ WORD Day-ofweek (RTC) RTC Dwesk  RTC_Dweek
2 DIG_0UT1.0 DFES_vE.RTC Day 49955 0/WORD Day RTC) RTC_Day RTC_Day
=) DIG_OuT A DFES_vEB.RTC_Man 49956 0/wORD Morth [RTC) RTC_Mon RTC_Man
=) DIE_ouTr 2 DFES_vBRTC Year 45957 0/'WORD ‘Year [RTC) RTC_Vear RTC_Vear
~[=) DIG_0UT1.3 DFE5_v8.ScanCycleTime 49958 0/ WORD CPU Scan Cycle time in mil ScanCycleTime | ScanCycleTime
M=]0iG_0UT2 4 DFEF_vBDIG_0UTZ2 4 00005 0/ BOOL led4 DIG_OUT2 4 (DFS7GIRAN0NE
-2 DIG_OUTZE
[ DIG_OUTZE
[ DIG_ouT2?
[ TEMPO
~[Z) TEMP1
~[=) TEMP2
(=] TEMP3
(2] TEMP4
~[2) TEMPS
[ TEMPE
[ TEMP?
~[=) TESTO
~[=) TESTA
-[Z1 TF&RT 2 =l

Start Monitaring | Add to Grid | Clear Grid | Clear Fail Count | Tags Monitored: 22 1000 Sean Time [miliseconds) Cloze

Figure 32- Adding and removing status and variables
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Tag List Generator — User’s Manual

To start the monitoring, click on “Start Monitoring”. To end the monitoring, click on “Stop Monitoring”.
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File
Tan [Addess [Walus  [Type  [Qually [NbrOFFals [Tims [Desc [User Tag [Default Tag
StatusPort_SeniakR5 232.5 canPeriod 1000 Good 0 33827 PM
DFES_vB.DIG_IN.O 10001 0/BOOL  Good 0] 1:21:20PM | contral start DIG_IN.O DF20G1B8002.0
DFES_vB.DIG_IN.1 10002 0/BOOL  Good 0 T:21:20PM key 1 DIG_IN.1 DF20G1B8I002.1
DFEE_vB.DIG_IN.2 10003 0 BOOL | Good 0 1:21:20PH  key 2 DIG_IN.2 DF20G1B2I002.2
DFES_vB.DIG_IN.3 10004 0 BOOL | Good 0 1:21:20PM key 3 DIG_IN.2 DF20G1BRI002.3
DFES_vE.DIG_IN.4 10005 0/BOOL  Good 0] 1:21:20PM kep 4 DIG_IN.4 DF20G1B8I002.4
DFES_vB.DIG_IN.S 10006 0/BOOL  Good 0] 1:21:20PM kep 5 DIG_IN.5 DF20G1B8I002.5
DFES_vB.DIG_IN.E 10007 0/BOOL  Good 0] 1:21:20PM key & DIG_INE DF20G1BEI002.6
DFES_vB DIG_IN.7 10008 0 BOOL | Good 0 12120 PH  key 7 DIG_IM.7 DF20G1B2I002.7
DFES_wBINTC_1 42560 T INT Good 0 1:21:20PM INTC_1 OUTLICT A
DFES_vBINTC_2 42561 2| INT Good 0/ 1:21:20PM INTC_2 QuT2ICTA
DFES_vBINTC_ 3 42562 3| INT Good 0/ 1:21:20PM INTC_3 QuTaICTA
DFES_vE.TOTAL 42863 3/ INT Good 0] 1:21:20PM TOTAL QUT.ADDA
DFES_vBRTC_Sec 43351 13WORD | Good 0 1:21:20 PM | Seconds [RTC) RTC_Sec RTC_Sec
DFES_vB.RTC_Min 43952 20/ WORD | Good 0] 1:21:20PM | Minutes (RTC] RTC_Min RTC_Min
DFES_vB.ATC_Hour 43953 10/ WORD | Good 0/ 1:21:20PM | Hou (RTC) RTC_Hour ATC_Haour
DFES_vB.ATC_Dwesk 43954 4/'WORD | Good 0] 1:21:20PM| Day-a-week [RTC) RTC_Dweek |RTC Dweek
DFES_vB.RTC Day 43955 1/WORD | Good 0/ 1:21:20PM | Day [RTC) RTC_Day RTC Day
DFES_vB RTC_Mon 43356 E WORD | Good 0 1:21:20 PH | Month [RTC) RTC_Mon RTC_ton
DFES_vB.RTC vear 43957 5/WORD | Good 0] 1:21:20PM| Year [RTC) RTC_Year RTC_vear
DFES_vB.5canCycleTime 43958 10 WORD | Good 0 1:21:20 PM | CPU Scan Cycle time in mil ScanCycleTime | ScanCypoleTime
DFES_vB.DIG_0UT2.4 00005 0/BOOL  Good o ledd DIG_OUT24 | DF27GZB40003.4

Stop Monitoring | Additg Grid | [Clear Grid | Clear Fail Count | Tags Monitored: 22 1000 | Sean Time [miliseconds] Close

Figure 33-Monitoring example of the DF65 OPC Server using OPC Monitor
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